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Here at PET, we’re always trying to make the news-

letter and website better for our subscribers. This 

involves not just creating good print articles and 

tutorials online, but also doing things that make your 

subscription more valuable. Well, we’re really happy 

to announce that we’ve struck a deal with B&H Photo 

(you know, that tiny camera store in New York City) 

to offer free Standard UPS shipping to PET subscrib-

ers. This offer will be available within the Continental 

US. This is huge. If you place just a few orders for 

camera gear, electronics or software a year, you’ll 

more than cover your annual subscription fee here 

at PET. Subscribers will have a special number to 

call when they place their order. Keep an eye on the 

subscriber website for more info. As for the newslet-

ter, we’ve got lots of great articles for you again. The 

Lightroom column went over very well last time, so 

we’ll be continuing it. Lightroom is definitely a great 

place to work on your photography, so I urge you 

to take a look, as it’s quickly becoming the future of 

processing your photos. We’re also fortunate to have 

Diana Day back with a tutorial on creating chalk-

board effects and Larry Becker shows us how to add 

3-D type to your images. And if you’ve ever traveled 

to a great location only to find cloudy skies in your 

photos, Matt Kloskowski has a great tutorial on how 

to make the most out of the photos you take. Finally, 

since Easter is around the corner, we included some 

tips for taking great photos that day. And we’re very 

please to have the very talented Tamara Lackey share 

some of posing tips, so your photos can look even 

better coming right out of the camera. 

One more thing. We always keep an eye on the 

website and feedback that you give and I wanted 

to let you know that we’ve heard your thoughts (ok, 

demands) to bring the Subscriber Showcase and 

Photo Challenge back. The theme for the next Photo 

Challenge will be “Bridges”.  We’re working on getting 

your best images and we’ll be sure to include it in the 

next issue.  See you next time! 

 

Rick LePage

rick@photoshopelementsuser.com
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Make a Scene with 3D Text
Usually when we think of adding 3-D type to an image, it usually ends up looking like an after-thought. But there’s 

an easy way to incorporate the texture of your image directly into your type and make an impressive text design that 

looks like it belongs there, and it will probably have lots of viewers wondering if the letters were really cut out of your 

background material.

1 This technique works with  

concrete, marble, and even 

textured metal surfaces, but in real 

life I work with wood, quite a bit, so I 

photographed a neighbor’s fence to 

use as my backdrop. (I’ve provided 

 this file so you can follow  

along.) Start by opening the  

file “Fence_for_text.jpg” and 

select the Text tool by pressing 

the T on your keyboard. Make 

sure you’re in Expert mode  

and that your Layers panel is 

visible on the right.

2 This works best with bold, fat letters that 
don’t have the little feet (sans serif) and you 

should use all caps. I chose Helvetica Compressed 
and I set my font size to 400p and my leading to 
320p. Then I typed in PRO FENCE on two lines. My 
colors were set to default so my type was black, 
but the color doesn’t really matter. Click the green 
checkmark to confirm that you want to create that 
text layer and then get the Move Tool by pressing V. 
Move your text somewhere other than the middle, 
like the bottom right.

3 Turn off the visibility of your text layer by clicking the little eyeball at the left of the text layer in the Layers panel. Hold down 

the Control key (Command Mac) and click once on the text layer thumbnail in the Layers panel to create a selection in the shape of 

your type. Click on the background fence layer to highlight it and, with your selection still doing the marching ants thing in the shape of 

the letters, press Control-J (Command-J Mac) to create a new layer of wooden letters. 

Note: you won’t be able to see the letters in your main view but you will see the letters  
on their own layer in the Layers panel. If you temporarily turn off the visibility of the  
background layer, you’ll see wooden letters in your main working area. 

Version Note: This tutorial uses and references steps as they appear in Photoshop Elements 11, but the techniques all work in version 
10 and most steps work in earlier versions as well. It’s just that some features are accessed in a different way.

To download the 
starting photo go 
to the Magazine 
section of the 
website and click 
on the March/April 
2013 issue. 
Photoshop 
ElementsUser.
com

 EXTRAS  
TRY IT AT HOME

4 There are some small, vertical gaps between 

boards in this wooden fence and they’ll look funny 

in the final version, so the gaps need to be patched. With 

the wood type layer selected (and the visibility of all other 

layers turned off), zoom in to at least 50% and then click the 

“Lock Transparency” option at the top of the Layers panel. 

Now you can press J to access the Spot Healing Brush tool. 

Alt-Click (Option-Click on Mac) to select some good wood 

somewhere else as your “Sample From” selection. Then 

paint over the gaps to hide them. You may need to set a 

new “Sample From” point occasionally.
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5 Click the little eyeball to turn on the 
visibility of your Background layer once 

again, and then press V on the keyboard to select 
the Move tool. If you have “Show Bounding Box” 
checked in your tool options panel, you’ll see a 
bounding box around your wood letters, though 
they’ll still be impossible to see since they blend 
with the background. Click in the box and drag 
it to about the center of your image area. At this 
point you’ll start to be able to make out your 
wooden letters.

6 Now click the Effects 
icon at the bottom of 

the Layers panel to dis-
play available Layer Effects. 
At the top of the Effects 
Panel click the center tab 
to select Styles and from 
the drop down menu right 
below it, choose Bevels. 
Double-click the third one 
down on the left (Simple 
Sharp Inner) and your 
letters will be beveled. To 
adjust the bevel, click the blue gear icon to the 
right of the Bevels drop down menu, and adjust 
the size and angle to give the letters a carved, 
beveled dimensionality. 

7 Because the top of the Style Settings box 

has Drop Shadow adjustments listed, you 

can turn on a Drop Shadow by just checking that 

checkbox. In order to fine tune the Drop Shadow, 

click the triangle to the left of the Drop Shadow 

checkbox to reveal the 3 sliders. I set mine to Size: 

111, Distance 120px, and Opacity 69%. This is a matter 

of taste so feel free to adjust yours differently. When 

you’re happy with how it looks, click the Ok button 

to confirm the Effect settings. 

8 Now to make the wood of the text look just 

a bit different from the wooden background, 

we’ll need to change some of the lighting and colors 

of the background. Start by clicking on the background 

to select it. Next add a Hue/Saturation Adjustment 

Layer by clicking the New Adjustment Layer icon and 

choose Hue/Saturation from the menu. It will create 

the adjustment layer above the Background, but 

below your wooden text. In the Hue/Saturation dialog 

box move the sliders to change the Hue, Saturation 

and Brightness to make it noticeably different from 

your beveled letters. I dropped all 3 values to add a 

hint of red to the wood and desaturate the colors as 

well as slightly darken them. 

It’s fairly easy to create photographic 
letters that look like they’re really made 
out of your background material as long 
as you pull your texture from somewhere 
other than its final position, and always 
remember that slightly adjusting the 
color tint and lighting will help sell the 
effect even more. Now go take some 
pictures of wooden desks, marble coun-
tertops, or scuffed up sheet metal and 
try your own design. ■

Larry Becker is a photographer and an 
instructor. He has taught Photoshop at 
the college level and conducted Photoshop 
Elements seminars for Adobe. His work has 
appeared on the sites of many major tech-
nology training companies.
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Don’t Let Cloudy  
Skies Get You Down
Sometimes we don’t get to shoot in perfect weather. 
Especially when you’re traveling—you simply don’t get 
to pick the weather forecast for the day. Trust me, it’s 
happened to me more times than I care to count. I get 
somewhere really beautiful, and I’ve got cloudy gray 
skies. Well, there’s a sweet little adjustment in Elements 

that can take those gray skies and make them look pretty 
darn cool and dramatic. It’s not going to turn a cloudy 
rainy day into beautiful sunlight mind you. But more 
often than not, I think you’ll find this adjustment can 
make the clouds the star of the photo and you may even 
find yourself shooting on cloudy days more often. 

4 The rest is pretty simple—just click-and-
drag on the sky to paint the effect on the 

photo. You’ll start to see the dramatic clouds 
(that you knew were there when you took the 
photo) showing up wherever you paint. By the 
way, notice how Elements automatically started 
adding the contrasty effect to parts of the sky 
that you haven’t even painted over yet? That’s 
where the “smart” part of this brush comes into 
play. It automatically examines your photo for 
areas similar to what you have painted on and 
adds them to the selection.

5 Don’t forget to brush on the areas of 
sky behind the bridge. You’ll have to 

zoom in and reduce the size of your brush 
to around 10-20 pixels to get in there. And I 
wouldn’t worry about getting every little area, 
as you won’t see the details as much there. 

6 Okay, this brush is pretty cool, right? But 
it’s not perfect. There will inevitably come 

a time (probably sooner than later) where 
the “smartness” of the brush isn’t as smart as 
it thinks it is, and it bleeds into a part of the 
photo you didn’t want it to (like the dark areas 
on the bridge in the previous step that acci-
dentally got selected too). When that happens, 
press-and-hold the Alt (Mac: Option) key to 
put the brush into subtract mode. Then paint 
over the areas you didn’t want to apply the 
effect to (as shown here). Again, Elements will 
do a lot of the work for you and wipe away the 
areas, even if you don’t paint directly on them. 

Note: I find decreasing the brush size when I’m 
doing this helps me get better results when 
removing areas I don’t want affected.

1Open a photo where you’ve got some 
cloudy gray skies. I took the photo here on a 

trip to Portland, which has no shortage of cloudy 
skies at certain times of the year. Then, select the 
Smart Brush tool from the Toolbox (it’s the large 
paint brush icon in the Enhance section) or just 
press the F key. 

2 Once you select the Smart Brush tool, click on the thumbnail near the 
left side of the Tool Options Bar to open the Preset Picker. As you change 

the Presets pop-up menu and scroll through the Preset Picker, you’ll see there’s 
a ton of presets to choose from. Let’s go ahead and choose Nature from the 
pop-up menu, though, to narrow it down. Then click on the add contrast to 
cloudy skies thumbnail in the top row , which adds contrast to cloudy skies.

3 Now the main thing to remember about this tool is that it is still a 
brush, which means it has settings just like all other brushes (size, hard-

ness, spacing, etc.). So, using the Size slider in the Tool Options Bar, choose a 
size that’ll help you paint over the area fairly quickly. In this example, I’m using 
a 200-pixel brush for the sky.
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7 Here’s another really cool part about the 
Smart Brush tool: it’s non-destructive to your 

photo. This means you can always go back and 
change (or even delete) the effects. You’ll see this 
in two ways: First, you’ll notice that the Smart 
Brush tool automatically adds a new adjustment 
layer to the Layers palette. If you ever find that 
the effect is too harsh, you can always reduce the 
opacity of the layer to reduce the effect (which I 
don’t want to do here because I like the effect, but 
I just thought I’d let you know).

8 You may have noticed a tiny red box on your photo where you started to paint 
with the Smart Brush tool. This is the adjustment marker, letting you know you’ve 

applied a Smart Brush adjustment to the photo. If you Right-click on it, you’ll see you 
can delete it if you want or you can change the adjustment settings. Choosing Delete 
Adjustment does just what you think it does—the adjustment will be removed totally. 
But try choosing Change Adjustment Settings instead. It brings up the Adjustments 
palette or dialog with the controls for whatever adjustment Elements used to achieve 
your effect. If you’re familiar with that Adjustments palette or dialog, you can always try 
tweaking the settings. In this case, Levels was used, so the Levels dialog appeared. 

Here’s the final before and after images so you can see them side-by-side  
and see what a dramatic difference it makes in the sky. 

Matt Kloskowski is Education and Curriculum Developer for the National Association of Photoshop Professionals. He has authored several 
books on Photoshop and Illustrator. His latest book is The Photoshop Elements 10 Book for Digital Photographers (New Riders Press; 2011), 
coauthored with Scott Kelby. Matt also teaches Photoshop Lightroom at LightroomKillerTips.com and has a blog about Photoshop and 
Photography at www.mattk.com.

Before

After
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It’s no secret that chalkboard creations are all the rage 
now. Images of beautifully chalked signs and cards 
abound on blogs and other social networking sites 
such as Pinterest, Tumblr, and Facebook. Many of them 
are intricately hand-lettered, spelling out words of 
wisdom, witticisms, event promotions, and commercial 

advertising. Although I’m not skilled at hand-lettering, I 
am so enamored by fonts, words, and typography, that 
I couldn’t help but try my hand at a digital chalkboard 
design. Join me in the fun as I walk you through the 
steps to create your own.

Chalk One Up 
Creating a Digital Chalkboard Sign

1 Our first task is to create a realistic-looking chalkboard.  

Decide on the size and dimensions you need for your sign. I’ll make my exam-

ple image 8.5” x 11” with a resolution of 300 pixels/inch. Click New>Blank File 

from the File menu. In the New dialog, change the Width and Height increments 

to inches, and then enter your desired dimensions. The Background Contents 

value doesn’t matter since we’ll be filling it with a color.

2 Click the foreground color chip at the base of the toolbar to open the Color 
Picker. At the bottom of the color value column on the right side, type in 

333333.  Go to Edit>Fill Layer and in the Fill Layer dialog, click on the drop-down 
arrow next to Use, and select Foreground Color. This should give us a good slate 
color to start out with for our chalkboard. 

3 A real chalkboard isn’t one solid 
color, so let’s add a couple effects to 

our image to make it look more realistic. 
First, add some noise – Filter>Noise>Add 
Noise – with these settings: Amount 1%, 
Distribution Gaussian, and monochromatic. 
To give the blackboard more texture, go to 
Filter>Artistic>Smudge Stick and choose the 
following settings: Stroke Length 10, High-
light Area 0, and Intensity 0. You may not see 
a great deal of change to the image until you 
zoom in 100% on it.
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5 Decide on the message you wish 

to display on your sign and what 

types of fonts you like for the message. 

Ignoring the most basic typography rules, 

popular designs for chalkboard signs 

use a variety of fonts and styles, with the 

words arranged in an especially ornate 

layout including dividers, borders, banners, 

swashes, and/or swirls, actually quite busy, 

in a somewhat vintage style. There is an 

abundance of free fonts available online 

to download, including dingbat fonts for 

decorative elements of all kinds. Pick out 

the fonts you’d like to use in your design 

and install them ahead of time. Try to find 

“sketchy” looking fonts, rather than bold 

ones with sharp edges, to more resemble 

chalk drawings. Open a font file by double-

clicking on it and you should see a sample 

of the font as well as an Install button (on 

a Mac, just double-click and choose Install 

Font). Look for more suggestions and tips 

in the online magazine Extras.

6 Now the fun begins – add your 

message to the chalkboard. Select 

the Type tool (T), choose white as the font 

color, and a plain font to start with. Break 

the message up into separate words or 

phrases to more easily change the fonts 

and reposition words later. Remember 

that you will most likely be rearranging the 

words several times before you come up 

with a placement that you like – kind of 

like word refrigerator magnets.

For each word or phrase, click on the 

chalkboard or drag out a text box, type the 

desired text, and then click the checkmark 

to commit the text. For the next phrase, 

select the Type tool again, click on a blank 

spot, and repeat for each word or phrase 

you want on a separate layer. To minimize 

accidently selecting an existing type layer 

when trying to start a new one, go to the 

Move tool’s options bar, and make sure 

“Auto Select Layer” is not checked.

To try various fonts and sizes, simply 

double-click on the “T” icon in the layer 

for the word or phrase you want to change 

and from the options panel, choose a 

different font and adjust the size. To repo-

sition text, while it is selected, press Ctrl-T 

(free transform) and then drag the text to a 

new position. Try warping or angling some 

of the text to add interest.

7 Let’s add some decorative elements. 
Dingbat fonts are ideal for this purpose. 

There is such a variety of them available free 
to download online ( just do a quick search 
for “Free Dingbat Fonts” on Google.com). 
Using a font viewer application is invaluable 
when trying to find a design you need within 
all the dingbats you’ve collected.

Texture Downloads

Font Family

Font Color Warp

4 Download the texture file I used, 

or another one of your choosing, 

and open the file in Elements. Go to 

Image>Rotate to rotate it, if needed to 

match the orientation of your image. 

Select the Move tool (V) and start drag-

ging the texture over to the chalkboard. 

Before dropping the texture onto the 

chalkboard, depress the Shift key, so 

the texture comes in centered above 

your background layer. Then close the 

original texture. Using the bounding box 

handles, drag the top, bottom, and sides 

of the texture to match the size of the 

chalkboard. If necessary zoom out until 

you can see the entire bounding box. 

In the layers panel, click on Normal to 

open the blending modes menu located 

at the top of the layers panel, and select 

Overlay. Adjust the Opacity to 45%. 

There you have it – a realistic-looking 

chalkboard, ready to add the lettering.. 

A well-used chalkboard accumulates a 
considerable amount of scratches and shad-
ing over time. To get this effect, I searched 
a few of my favorite online texture sites for 
an appropriate texture. I found the perfect 
texture in a set provided free by designer 
Caleb Kimbrough at his blog, Lost and 
Taken, at this URL: http://lostandtaken.com/
blog/2010/7/16/17-scratched-and-scraped-
textures.html (I used the first image in the 
texture set). 
Look for the direct link to these textures, 
links to fonts and other resources to use in 
your images, as well as further examples of 
chalkboard signs, in the online Extras under 
the Magazine section for the March/April 
2013 issue at PhotoshopElementsUser.com.
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8 After getting all your text set in the fonts 

you want, along with decorative borders and 

other elements placed on your sign, if you’re like me, 

you still have some tweaking to do. I rearranged my 

groups of words and phrases, with their frames and 

embellishments, several times, until I was satisfied 

with the design. To make it easier to keep groups of 

layers together so they can be moved together, rather 

than separately, it’s a good idea to link related layers. 

To do that, Ctrl-click (Mac: Command-click) on each 

layer you wish to link, then right click on the selected 

layers and choose Link Layers from the menu.. 

9 To finish off my chalkboard sign, I added an 
erased chalk look to the edges and a thin border. 

Create a blank layer above the texture layer we 
added in Step 4. I suggest you turn off the visibility of 
all the layers above, by clicking the eye icon beside 
the layers, to get a clear view of the background. Get 
the Brush tool (B) and select the Dry Media Brushes 
set, and the last brush in that set. Lower the opacity 
of the brush to about 10%, size the brush quite large, 
and with the white foreground color, gradually stroke 
the edges of the image, trying to keep the inside 
edges of the “chalk dust” blended rather than sharp. 
Then lower the opacity of that layer even more, to 
about 50% to 60%, so it looks like erased blackboard. 

10 To make a thin border, create a blank layer at the top 
of the layer stack, grab the Rectangular Marquee, and 

drag out a selection an equal distance from the edge all around. 
Turning on the Grid (View>Grid) will help you get an even 
selection. From the Edit menu, select Stroke (Outline) Selection. 
In the Stroke Dialog, enter the pixel width for your border, the 
color white, and the location Inside. ■

ELEMENTS TIP:  
Quickly Create  

a New Layer: Pressing Ctrl-Shift-N 
(Mac: Command-Shift-N) creates a 
new layer, but it brings up the New 
Layer dialog so you can name it. 
Personally, I find it kind of annoying 
and it’s not much faster than just 
clicking the new layer icon. 
However, if you throw the Alt (Mac: 
Option) key into the mix, Ctrl-Shift-
Option-N (Mac: Command-Shift-
Option-N), then it’ll bypass the new 
layer dialog and just create a new 
blank layer in the Layers panel. 

ELEMENTS TIP:  
Cycling Through Your Blend 

Modes: Sometimes it’s useful to 
quickly cycle through your blend 
modes to see which one works best. 
Manually clicking on each one just 
isn’t quick, so try this: Click on the 
Blend Mode list in the top left of the 
Layers panel to select a blend mode. 
Then press Shift-+ to cycle down the 
list and Shift-– to go back up. 

Diana Day is a self-taught Elements user, and she 
teaches Elements to members of her community 
by hosting a PSE Users Group, presenting at 
meetings and workshops of photography groups, 
and tutoring Elements users one-on-one in their 
homes. Diana also performs photo editing ser-
vices for photographers and does photo restora-
tion for genealogists when called upon.
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Posing Tips From The

 Posing
 Playbook
In my ten years of experience 
photographing children, I have 
found one universal truth
that remains constant:  most kids 
don’t do posing. That being said, 
many kids are amenable to being 
moved this way and that and 
often will take posing direction 
beautifully—you just have to use 
an entirely different language to 
get them to do so, and it often 
isn’t verbal. Oh, and they also 
won’t do it for very long.

For me personally, I have found the act of referencing my past “wins” to be extraordinarily inspirational when 
I’m in the middle of a shoot and, frankly, just running out of portrait concepts. I’d started by bringing small proof 
prints with me to a shoot, then moved on to a large binder and finally, blessedly, found the maximum ease by 
toting an electronic album on my iPhone. I would glance through the images to spark new ideas—but eventually 
I started finding the listing of metadata to be quite useful, and any time Past Me jotted down additional 
information about exactly how those poses were achieved—what lighting was used, what games I played in 
certain situations, and any other helpful information—was quite appreciated by Present Me.

For this first image, I wanted a lovely, loving image of 

mom and daughter together. That was my goal.  I set 

them up on a small outdoor loveseat just on the edge of the 

shade, so they were still well-lit, but not squinting. The 

daughter was D.O.N.E., as you can plainly see from her 

expression in this shot. 

So I turned my attention towards 

mom, improving her pose—and the 

overall composition of the shot—by 

tweaking the pillows around her and 

adjusting her dress a bit.  Often small 

changes like this go a long way in 

altering the overall feel of the image.  

Notice the change in just her body  

and comfort level, just with these  

little shifts.  

Then I told the daughter that I didn’t 

need her to do anything but get super 

snuggly with mom. Since she was now 

finished with such a hard shoot, after 

all, she should just take a break.  When 

she was able to be “finished,” her entire 

expression relaxed beautifully.

Camera Setting: 1/500 • f2.8 • ISO 100 • 
Metering: Partial

Many young girls love the freedom to simply model for you—especially when they hear you clicking away and murmuring your constant 

approval. They’ll show youtheir best catwalk moves, their most compelling hair flips and jut out their hips just like they’ve seen (other!) pro-

fessional models do.  Encouraging this can be a lot of fun, and I often say “You First” when it comes to posing girls.  And, truth be told, many 

boys. Basically, I let them show me their best stuff before we try some of mine.

Tips From The Posing Playbook | Tamara Lackey
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Photography Tips

POSING  
TIPS

• Place subjects at the edge of the shade to avoid squinting

•  Adjust props to make subjects more comfortable, improve  
body positioning

• Suggest child take a break from posing and just  get snuggly
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This subject strutted her stuff as I shot her in an open 

field, positioning her a fair distance from the trees 

behind. I shot from a lower angle, so she could more 

easily cat walk towards me, and the reflector was placed 

low and underneath her, to the right 

 

 

 

 

 

 

 

 

 

 

 

 

 

Then I told her that everything she did was fabulous 

and now it was my turn to try a model pose.  I used her 

idea to place her arms behind her back, like Image 4, but 

tweaked them a bit, crossing her legs and positioning all 

her weight on her back foot. I then jutted my chin out 

a bit and asked her to do the same. I adjusted my angle 

to shoot from her eyeline because I wanted a clearer 

image, cutting out some haze from the backlight, and 

because I felt like it was a more flattering angle for her. 

Then I suggested we try a different “look.” While she 

watched me trying out a few rather goofy ones, she tried 

to keep her smile in, and we achieved our final shot, a 

gorgeous expression.

Camera Settings: 1/160 • f 2.5 • ISO 320 • Metering: Partial

I photographed this family of four, at a park, on a late 

summer afternoon. Since the little boy was hopping around 

the park so much anyway, I thought it’d be fun to get an image 

of him and his sister jumping off a rock together. The problem 

was that they were unsure of their landing and kept looking 

down as they jumped. 

So I positioned them to jump from a much higher rock and had 

mom and dad hold their hands for safety. Then I laid down, 

back on the ground. Since that changed the angle and composi-

tion of the shot dramatically, I tilted my lens up a bit to include 

the natural framing element of the tree branch—then told them 

to try to jump on me. That way they could look down, and I 

could also capture their great expressions. It made for a signifi-

cantly more interesting capture.  And I rolled out of the way as 

quickly as I could after stabilizing my shot. ■

Camera Settings: 1/320 • f3.2 • ISO 500 • Metering: Evaluative

Tips From The Posing Playbook | Tamara Lackey
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Tamara Lackey is a portrait photogra-
pher whose work has appeared widely in 
media outlets, from O Magazine to Men’s 
Journal and Parenting Magazine. Her 
latest books are “Envisioning Family”  
and “The Posing Playbook”, both avail-
able at tamaralackey.com. 

POSING  
TIPS

•  Having your subject try out 
some of her best modeling 
moves can lift the mood and 
open up pose ideas

•  Position your subject a dis-
tance from the background 
for a sharper portrait

•  When it is your turn to pose 
her, shoot from the most flat-
tering angle

•  To keep your subject from 
feeling awkward in the pose, 
have her try a variety of 
“looks” until she relaxes

POSING  
TIPS

•  Get the whole family involved in the action

•  Change your angle and be sure everyone is looking towards the lens

•  If anyone is wearing a dress, be sure to position them modestly

• Utilize natural framing elements
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Sharpening Your  
Photos In Camera Raw
In Elements, we have pro-level sharpening within 
Camera Raw. So when do you sharpen here, and when 
in Elements? I generally sharpen my photos twice—once 
here in Camera Raw (called “capture sharpening”), and 

then once in Elements at the very end of my editing 
process, right before I save the final image for print or for 
the web (called “output sharpening”). Here’s how to do 
the capture sharpening part in Camera Raw:

4 This may seem kind of obvious (since it 
tells you this right at the bottom of the Detail 

panel, as seen in Step One), but so many people 
miss this that I feel it’s worth repeating: before you 
do any sharpening, you should view your image 
at a 100% size view, so you can see the sharpening 
being applied. A quick way to get to a 100% size 
view is simply to double-click directly on the Zoom 
tool (the one that looks like a magnifying glass) up 
in Camera Raw’s toolbar. This zooms you right to 
100% (you can double-click on the Hand tool later 
to return to the normal Fit in Window view).

5 Now that you’re at a 100% view, just for 
kicks, drag the Amount slider all the way to the 

right so you can see the sharpening at work (then 
drag it back to its default of 25). Again, dipping into 
the realm of the pain fully obvious, dragging the 
Amount slider to the right increases the amount 
of sharpening. Compare the image shown here, 
with the one in Step Four (where the Sharpening 
Amount was set to the default of 25), and you can 
see how much sharper the image now appears, 
since I dragged it to 100.

6 The next slider down is the Radius slider, 
which determines how far out the sharpen-

ing is applied from the edges being sharpened in 
your photo. I leave my Radius set at 1 most of the 
time. I use less than a Radius of 1 if the photo I’m 
processing is only going to be used on a website, 
in video editing, or something where it’s going to 
be at a very small size or resolution. I only use a 
Radius of more than 1 when the image is visibly 
blurry and needs some “emergency” sharpening, 
or if it has lots of detail (like this photo, where I 
pushed the Radius to 1.2). If you decide to increase 
the Radius amount above 1 (unlike the Unsharp 
Mask filter, you can only go as high as 3 here), 
just be careful, because your photo can start to 
look oversharpened. You want your photo to look 
sharp, not sharpened, so be careful out there.

 Switch to Full Screen  
To have Camera Raw expand to fill your entire screen, click the Full  

Screen icon to the right of the Preview checkbox, at the top of the window.

1When you open a RAW image in Camera Raw, by default it applies a small 

amount of sharpening to your photo (not the JPEGs, TIFFs, or PSDs—only 

RAW images). You can adjust this amount (or turn if off altogether, if you like) by 

clicking on the Detail icon (circled here in red), or using the keyboard shortcut 

Ctrl-Alt-2 (Mac: Command-Option-2). At the top of this panel is the Sharpen-

ing section, where by a quick glance you can see that sharpening has already 

been applied to your RAW photo. If you don’t want any sharpening applied at 

this stage (it’s a personal preference), then simply click-and-drag the Amount 

slider all the way to the left, to lower the amount of sharpening to 0 (zero), and 

the sharpening is removed. Oh, and you can stop reading at this point because 

none of the other settings do anything if your sharpening amount is set to 0.

2 If you want to turn off this “auto matic-by-

default” sharpening (so image sharp ening is 

only applied if you go and man ually add it yourself), 

first set the Sharpening Amount slider to 0 (zero), 

then go to the Camera Raw flyout menu and choose 

Save New Camera Raw Defaults (as shown here). 

Now, RAW images taken with that camera will not be 

automatically sharpened.

3 Before we charge into sharpening, there’s one more thing you’ll want 
to know: if you don’t actually want sharpening applied, but you’d still like 

to see what the sharpened image would look like, you can sharpen just the 
preview, and not the actual file. Just press Ctrl-K (Mac: Command-K) while 
Camera Raw is open, and in the Camera Raw Prefer ences dialog, choose 
Preview Images Only from the Apply Sharpening To pop-up menu (as shown 
here), and then click OK to save this as your default. Now the sharpening 
only affects the preview you see here in Camera Raw, but when you choose to 
open the file in Elements, the sharpening is not applied.
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Before

After

9 All four sliders in the Sharpening section of 
the Detail panel let you have a live preview of 

what the sharpening is affecting—just press-and-
hold the Alt (Mac: Option) key as you drag; your 
screen will turn grayscale, and the areas that the 
slider you’re dragging will affect appear as edge 
areas in the Preview area. This is particularly helpful 
in understanding the Masking slider, so press-and-
hold the Alt key and drag the Masking slider to the 
right. When Masking is set to 0, the screen turns 
solid white (because sharpening is being evenly 
applied to everything). As you drag to the right, 
in the preview (shown here), the parts that are no 
longer being sharpened turn black (those areas are 
masked). Any areas you see in white are the only 
parts of the photo receiving sharpening (perfect for 
sharpening women, because it avoids sharpening 
their skin, but sharpens the things you want sharp, 
like the eyes, hair, eyebrows, lips, edges of her face, 
and so on). Below is a before/after of our boat deck 
shot, with these settings—Amount: 100, Radius: 1, 
Detail: 78, Masking: 0. ■

7 The next slider down is the Detail slider, 
which is kind of the “halo avoidance” slider 

(halos occur when you oversharpen an image 
and it looks like there’s a little halo, or line, traced 
around your subject or objects in your image, and 
they look pretty bad). The default setting of 25 is 
good, but you’d raise the Detail amount (dragging 
it to the right) when you have shots with lots of tiny 
important details, like in landscapes, cityscapes, or 
the photo here, where I dragged it to 78. Other -
wise, I leave it as is. By the way, if you want to see 
the effect of the Detail slider, make sure you’re at 
a 100% view, then press-and-hold the Alt (Mac: 
Option) key, and you’ll see your preview window 
turn gray. As you drag the Detail slider to the 
right, you’ll see the edges start to become more 
pronounced, because the farther you drag to the 
right, the less protection from halos you get (those 
edges are those halos starting to appear).

8 I’m going to change photos to show you the Masking slider. This 
one’s easier to un derstand, and for many people, I think it will become 

invaluable. Here’s why: When you apply sharpening, it gets applied to the 
entire image evenly. But what if you have an image where there are areas 
you’d like sharpened, but other softer areas that you’d like left alone (like the 
photo here, where you want to keep her skin soft, but have her eyes, lips, 
etc., sharpened)? If we weren’t in Camera Raw, you could apply the Unsharp 
Mask filter to a duplicate layer, add a layer mask, and paint away (cover) those 
softer areas, right? Well, that’s kind of what the Mask ing slider here in Camera 
Raw does—as you drag it to the right, it reduces the amount of sharpening on 
non-edge areas. The default Masking setting of 0 (zero) applies sharpening 
to the entire image. As you drag to the right, the non-edge areas are masked 
(protected) from being sharpened.

This article is an excerpt from Scott Kelby and Matt Kloskowski’s Photoshop 
Elements 11 Book for Digital Photographers. For more info on the book and to 
purchase a copy, you can visit Kelbytraining.com as well as any online bookstore
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Okay, time for a quick intermission. So what are these cam-
era profile things, anyway? See, when you look at your photo 
in Lightroom, Adobe applies what’s called a profile to the 
photo that reads the colors and tones in that photo and dis-
plays them a certain way. In reality, Lightroom is displaying 
the closest thing to the untouched RAW image there is. This 
is usually less saturated and has more contrast than what you 
see in the camera. That’s because your camera automatically 
applies a “special sauce” (profile) to your JPEG preview that 
you see on the LCD. But Adobe simply honors the fact that 
you chose to shoot in RAW, so it’s showing you the RAW, 
untouched-in-any-way photo.

Now, if you look at your photo using the software that came 
with your camera (say Capture NX if you’re shooting with 
Nikon), you may find that you like the way the photo looks 
better in the camera vendor’s software than you do in Light-
room. Why? Because the software applies a different profile 
to read the photo (its color and tones) in a different way. Usu-
ally it’s because you had a picture control setting turned on 
in your camera. The photo may be more saturated. Maybe 
the skin tones look better, or maybe it has more contrast. In 
a nutshell, these camera profiles match the appearance given 
by the camera vendor’s software. After all, they’re applying a 
profile to it too, just like Lightroom.

3 Using camera profiles is really simple. Click on the Profile drop-down menu and select one you want to apply to your photo (in 
our example, we used Camera Vivid). You should immediately see a change in the photo. In this case, the colors should look much 

more vibrant and vivid (hence the name of the profile). What’s really neat is that this hasn’t changed any of the settings for this file in 
Lightroom, yet. If you look through your panels, all of your settings (Exposure, Blacks, Clarity, Vibrance, Saturation, etc.) are all at their 
default settings, as if nothing was touched. It’s basically giving you a better starting point, which is why I come to this first.

After

4 One of the things you’ll notice 
is that these profiles are camera 

specific. This is seamless to you though. 
Lightroom automatically recognizes 
which camera you used and shows you 
the correct profiles, so you won’t see 
any profiles other than those available 
for your camera. If you’ve ever used 
your camera vendor’s software, you’ll 
notice that the Lightroom profiles are 
named almost the same as they are 
in the camera software. Again, using 
Nikon as an example, Capture NX has 
something called Picture Control, which 
contains settings such as Vivid, Land-
scape, and so on.

5 Experiment with the different 
profiles and adjust the sliders and 

you’ll see some fairly drastic results. 
Some are definitely punchier than oth-
ers. The inevitable follow-up question 
when folks see these profiles in action 
is, “I love ’em. Now how do I apply them 
to a bunch of a photos without having 
to do each one individually?” The first 
step is to press G to enter the Library 
module’s Grid view. Then choose 
Photo>Develop Settings>Copy Settings.

1The camera profiles in the Camera Calibra-
tion panel have turned out to be one of my 

favorite features. It’s one that  I usually use first, yet 
it’s at the very bottom of the panels list. First select 
a photo to edit in the Develop module and scroll 
down the right-side panels area to the Camera 
Calibration panel. (I know, it’s in the worst possible 
place.) The good news is that you can also use a 
keyboard shortcut. Press Command-8 (PC: Ctrl-8) 
to jump directly to the panel without scrolling.

2 The profiles are listed under the Profile drop-down menu at the top—
directly below the Process version settings. If you expand the drop-down 

menu you should see a list of various profiles. What happens if you only see 
the word “Embedded” there? Ah, good catch. Here’s one important thing to 
remember: these camera profiles only work for RAW or DNG files—not JPEGs, 
TIFFs, or PSDs. So, if you’re working on anything but a RAW or DNG file, you’ll 
only see the word “Embedded,” and the rest of this tutorial won’t work for you.

Lightroom Camera Profiles:  

One of the Best  
Features in Lightroom
There’s a great feature in Lightroom called camera profiles. If you’ve ever looked at the back of your camera and 
thought your photo looked great, and then opened the same photo in Lightroom and been disappointed at how flat 
it looked, then you’re going to love this.

ELEMENTS TIP:  
Removing Noise from Cell Phone 

Photos: Ever think about using Elements to 
remove noise from cell phone camera 
photos? Hey, they’re great and all, but they 
have a tendency to have a lot of color noise 
in them - especially in low light photos. Give 
it a try. Download your photo to your 
computer. Open it in Elements and go to 
Filter > Noise > Reduce Noise. Go to the 
Color Noise slider and crank it up to get rid 
of that color grainy stuff that you see in the 
darker areas.  

WHAT ARE CAMERA PROFILES?
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7 Now select all the photos you want to apply 
the camera profile to. You can do this in the 

Grid view or down in the Filmstrip at the bot-
tom of the interface. Choose Photo>Develop 
Settings>Paste Settings and your camera profile 
setting will be applied to all the photos selected.

8 You can also create 
presets from the 

profiles, which you 
can then batch apply as 
you’re importing photos. 
I love what the Camera 
Portrait preset does for 
skin tones and if I do a 
portrait shoot, it’s easier 
to apply the profile as I 
import my photos

In the Develop module, choose the camera profile you wish to 
create a preset for and click the Create New Preset icon (plus 
sign) in the Presets panel header on the left. Again, deselect 
everything except for Calibration. Name your preset something 
descriptive and click Create. In this example, since we set the 
profile to Camera Portrait, we named the preset “Nikon Portrait.” 
In the Import dialog (File>Import Photos), select your preset 
from the Develop Settings drop-down menu in the Apply Dur-

ing Import panel and all of the photos will automatically have 
that camera profile added.
Pretty cool stuff, huh? So, before you consider getting really mad 
at your camera (or your software) because you like the photos 
on that tiny LCD screen on the back of your better, check out 
these profiles. I think you’ll find you can now get the same great 
look with very little effort. ■

6      This will open the Copy Settings dialog. 
Since you don’t want to copy anything else 

here except the Calibration settings, click the Check 
None button, then click the Calibration checkbox to 
turn it on. Finally, click Copy to close the dialog.

I STILL DON’T SEE THE CAMERA PROFILES? 

I’ve often seen questions from people who are shooting in RAW but 
still don’t see all of the camera profiles listed. It’s probably because 
you’re using a camera that isn’t supported. Nearly all Canon and 
Nikon cameras are supported. There’s also some Leica and Pentax 
camera support. Unfortunately (other than Google searches for 
custom profiles), there’s no other cameras supported, but Adobe 
has a free DNG Profile Editor that’ll let you create your own. You can 
download it at http://labs.adobe.com/wiki/index.php/DNG_Profiles. 
To get started using the DNG Profile Editor, go to http://labs.adobe.
com/wiki/index.php/DNG_Profiles:Editor.

ELEMENTS TIP:  
How to Change the Order of the 

Brushes in the Brush Picker: Let’s say you 
have a favorite brush in the Brushes palette, 
but it’s always at the bottom of the list. You 
can move them to exactly the place you 
want. Just go to Edit > Preset Manager, when 
the dialog opens, go to the Brushes section. 
By default it’s set to display all your brushes, 
so now all you have to do is click-and-drag 
them into the order you want them. When 
you’ve got everything in the order you want, 
click the Done button.
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Having a versatile lens while traveling let’s 
you take wide angle photos like you see 
here of the Eiffel tower and then a few 
minutes later at the Louvre you can zoom 
in to get a totally different type of photo.

The  
All-In-One  

Zoom 
Lens

If there’s one question that 
I hear all the time from 
photographers it’s “What 
lens should I buy?”. Now, 
the answer back to them 
usually depends on what 
they want to shoot, but 
there is one general lens 
that I’d recommend just 
about anyone have. It ’s 
an all-in-one, 18-200mm 
zoom lens. It ’s great for 
just about everything 
from travel, to sports, to 
landscape photography, 
and it’s just a great overall 
walking-around street 
photography lens. 
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TRY BEFORE YOU BUY
One more thing to consider is trying the lens out before you buy 

it. There are several lens rental companies out there that’ll let you 

rent the lens for a few days, to several weeks. It’s a great way to test 

out a lens before you actually pull the trigger and buy it. One of 

our partners here at PET is LensProToGo.com. They ship you the 

lens in a bulletproof case with the return shipping label all ready 

to go.  ■ 

WHAT ABOUT FULL FRAME?
If you have a full frame DSLR camera, then you’ll want to get the 

full frame equivalent of this lens. Nikon, Canon, and Tamron and 

Sigma all make a 28-300mm lens. They range in price from $630, 

all the way to $2500 so be sure to check out the lens for your 

specific camera model. 

Nikon 18-200  

$84695  
B&H Photo

AF-S DX VR Zoom-NIKKOR 
18-200mm f/3.5-5.6G IF-ED, 

Photo courtesy of Nikon. 

Tamron 18-200 

$29900  
B&H Photo

18-200mm F/3.5-6.3 XR Di II, 
Photo courtesy of Tamron]

Sigma 18-200 

$49900  
B&H Photo

Canon 18-200

$69900

B&H Photo

Top of the Line

Middle of the Road For the Budget Conscious

Check out our recommendations 
on the nexrt page

The Price 
Is Right 

There are lots  
of excellent  

all-in-one lens 
available that’ll  
fit into almost  

any budget. 

PROS:

CONS:

 The main advantage of  
this lens is its versatility.  
A range from 18mm all the way 
to 200mm means that you can 
shoot wide landscapes and 
tightly cropped sports photos 
all with the same lens. It’s really 
amazing when you think about 
it. Carrying a lens like this is 
like carrying 3 lenses to get the 
same focal lengths (wide, mid-
range, and zoom). 

These lenses are also fairly 
light weight compared to 
everything else out there. 
For example, the 18-200 lens 
is smaller than a 24-70mm 
lens. Being smaller and lighter 
means that they’re easier to 
pack, carry around and move 
with. Plus, you usually don’t 
even need a camera bag since 
you won’t be changing lenses. 
And for you travelers out 

there, packing light is a huge 
advantage because you have 
less to carry. Also, it’s just safer 
to not lug around a camera bag 
with thousands of dollars of 
lenses in it.  

Speaking of not changing 
lenses, that’s a huge check-
mark in the “pro” column too. 
For starters, the more you 
change lenses, the more you 

risk getting dust and debris on 
your camera’s sensor. And I 
think anyone who’s ever had 
to change lenses knows that it 
takes time. Also, while you’re 
changing lenses (maybe from 
a wide lens to a zoom), you’re 
missing everything else that’s 
going on around you.

 These lenses typically don’t 
have low (wide) aperture 
settings like f/2.8 or lower. 
Most of them vary from f/3.5 
at the wide angle focal length, 
to f/5.6 when you’re zoomed in 
at the longer focal lengths. This 
means two things: 

1)  If you’re in low light  
situations, like indoors or  
shooting before sunrise or 
after sunset, then you risk 
not having a wide enough 
aperture setting to capture  

sharp photos without a tripod. 
Now, if you’re outside shoot-
ing at mid-afternoon then 
you don’t have to worry 
about it. You’ll have plenty 
of light to capture sharp 
photos. You’ll only notice this 
when the light starts fading. 

2)  Lower aperture settings will 
let us get that really shallow 
depth of field (sharp subjects 
with blurry/soft back-
grounds). Since these lenses 
don’t typically go all the way 

down to f/2.8 or lower, they 
won’t produce as soft or nice 
of a background as some of 
the more expensive, but less 
versatile lenses will. 

I’m going to list this as a 
con, but it’s not really a con. 
It’s sharpness. I’ve found that 
these all-in-one lenses aren’t 
quite as sharp as some of the 
more expensive lenses. But 
I’ll counteract that statement 
by saying you probably won’t 
notice. You’d need to open 

the image up full size on your 
computer screen, and zoom 
way in to see it. I think, for most 
people who simply share their 
photos online and in smaller 
prints (smaller than say, 20x30 
inches), you’ll never see this 
difference in sharpness. In a 
nutshell, does it exist? Yes, to a 
degree, but when it comes to 
being practical it’s not anything 
you’d ever notice. 
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This is a great technique for 

showing off your photos in a 

print, as well as a nice border 

for images to share on the 

web. It really helps emphasize 

the photography and lets 

you present your photos in 

a professional-looking way. 

Plus, it uses the Crop Tool in 

a really unorthodox way - to 

add image size, rather than 

reduce it. Let’s get started:

Creating Cool Canvas  
Borders For Your Prints

5 Lastly, just press the Enter (Mac: Return) key to commit your crop. After 
you press it, the extra area outside of your image, in the gray, will become 

blank white canvas area. To finish things up, I added some text at the bottom 
using Trajan Pro for the font. 

6 I think you’ll see that this technique looks really nice when printing your 
photos but, as you can see here, it also looks great when you’re sharing your 

photos online whether it’s a simple email, blog or social media page.  ■

1 In the Elements Editor, open the image to which you want to add addi-

tional blank canvas area. Press the letter D to set your Background color to its 

default white. But if you want to add a different color canvas, like black, just set 

your Background color accordingly.

2 If you’re in Maximize Mode or tabbed 
viewing, press Ctrl-– (minus sign; Mac: Com-

mand-–) to zoom out a bit (so your image doesn’t 
take up your whole screen). If your image window 
is floating, click-and-drag out the bottom corner of 
the document window to see the gray desktop area 
around your image. (To enter Maximize Mode, click 
the Maximize Mode icon in the top-right corner 
of the image window. To enter tabbed viewing, go 
under the Window menu, under Images, and choose 
Consolidate All to Tabs.

3 We’re going to use the 

Crop tool to add extra 

space to the image. Usually, 

we use the Crop tool to take 

away part of the image but it 

works well here too. Press the 

letter C to switch to the Crop 

tool and drag out a cropping 

border to any random size (it 

doesn’t matter how big or little 

it is at this point).

4 Now click on one of the corner handles 

of the crop border that you see on screen. 

Then drag it outside the action image area, into the 

blank gray area that surrounds your image. You’ll 

see the cropping border extends outside the image. 

This is the “extra” area that’ll be added as white 

canvas space (or whatever color you chose as the 

Background color in Step 1), so position it where 

you want to add the blank canvas space. Here, I’ve 

added the same amount of space on the left, right 

and top of the image. But I added about twice as 

much space on the bottom - you’ll see why next. 
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PUT THE SUN TO EVERYONE’S BACK
This tip works best when you’re taking photos early in the 

morning or late in the afternoon (when the sun is fairly low  

and not directly overhead). See, if you position the people  

in your photo so they’re looking at the sun, then you’ll have  

a bunch of squinty people in your photos. If you position  

them so the sun is at either side of their face, then it looks  

too contrasty and harsh shadows start to appear. But if you 

make sure the sun is behind them, then their eyes will be  

wide open and there won’t be harsh shadows on their face.  

Plus, the light the sun casts on their hair has a very cinematic 

look to it and helps to add more separation between them  

         and their background. 
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Photography tips & tricks: 

  Easter Photos 

SHOOT AT THE KID’S LEVEL
As adults, we often grab the camera and just start taking pictures 

at our eye level since it’s the most comfortable. But Easter Sun-

day is all about the kids. So get down on their level. Be part of 

the action. Run around with them and capture photos of them 

having a great time, rather than trying to pose them for shots 

they don’t want. Think of this as a journalistic exercise rather than 

being the official photographer of the day. Oh, and candy (which 

there should be plenty of on Easter) makes a great bribe if you do 

need them to pose.  

CAPTURE THE DETAIL 
PHOTOS UP CLOSE
The detail photos can be great in photo books. 

They provide filler pages in between all of the 

great portraits. Some tips to capture good detail 

photos are to shoot patterns. Whether it’s Easter 

eggs, baskets, candy, or flowers. They all look 

great as backgrounds (or full pages in a photo 

book) when you’re showing off your Easter 

photos. Oh, and you don’t need a fancy lighting 

setup to do it. Some of the best lighting for detail 

photos like these, is natural light. Whether it’s 

outside, or you simply put the Easter basket near 

a window, natural light can really help make your 

photos stand out. 

Easter is right around the corner. You’ll find a ton of photo opportunities surrounding the entire day, as well as the days 
leading up to Easter. So we thought we’d include some photography tips to help you make the most of the holiday.  
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THE RIGHT LENS FOR THE EASTER  
EGG HUNT AND OUTDOOR PORTRAITS
This tip is great because it’s a formula you can follow over and over again when it comes to taking photos of the Easter egg hunt. First, 

grab the longest telephoto lens you have (18-200, 70-300, 70-200). Then put some distance between you and the kids. Basically, get far 

enough back to where you can zoom in all the way, and the kids still fill most of the frame. Next, set your camera on Aperture Priority 

mode so you can control the Aperture setting. Finally, set the aperture on it’s lowest setting for that lens. Depending on your lens (well, 

really it’s depending on how much you paid for your lens), it may go down to f/3.5 or f/5.6 when zoomed in. Really good lenses (AKA: 

really expensive lenses) may go down to f/2.8 or lower. Basically, the lower the aperture, the softer the background and the better your 

kids will stand out from it, and really pop off the picture. Oh, one more thing. It helps if whatever the kids are in front of is at least a 5 feet 

behind them (or more). In a nutshell, the combination of you standing way back and zooming, and them standing 5-10 feet in front of 

their background creates separation. Separation, when used with a low aperture setting, gives you the professional-looking photos that 

you see here.  

DON’T 
TELL 

THEM
TO HOLD  

UP THE  
EASTER  
BASKET

I’ve photographed Easter enough time 
with my own kids, as well as my nieces and 

nephews, to know one thing. When you 
tell a kid to hold up their Easter basket or 

Easter egg, you know what happens? They 
do exactly what you say. They hold it up high 
and proud… right in front of their face. While 

it can make a cute photo to get them peaking 
through the basket, you’ll probably have  

better luck to simply ask them to stand with 
their Easter basket at their side or ask them to  

hold it in front of their tummy or belt.  ■ 


